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Employee Self Service (ESS)  

Introduction 

iVisions Web Portal Employee Self Service (ESS) provides employees online access to 

Business Resources, Employee Resources, and Human Resources information. 

Accessing information within ESS is determined by the security role assigned to each 

employee. 

Launch Employee Self Service from Infinite Visions Accounting > Log into 

iVisions ESS, or from within iVisions, click the 9-Box and select the ESS 

icon. 

Log into the web portal as omoney (omoney, v, SSN 4644), who is the business 

manager and has a high level of access to the portal. Remember, your level of access 

may be different depending on the district configuration and your assigned security 

role. 

Once logged in, the ESS Welcome page displays. 

 

ESS Welcome Page 

 

 

 

 

Section Topics 

• Tools Panel and Menu 

Ribbon  

• Self Service Menu 

• Review Pay/Tax Info 

• Work with Benefits 

• Enter Expense 

Reimbursements 

• Access My Workflow 
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TOOLS PANEL AND MENU RIBBON  

Overview 

The Welcome page displays a Tools panel and Menu ribbon for use in navigating 

through the web portal. On the menu ribbon, a Search field is available to find 

something specific within the portal. 

Tools Panel 

ICON DESCRIPTION 

 

Click this icon to display the Messages tab. Compose new 
messages, review sent and archived messages. 

 
Click this icon to view any received notifications. 

 

Click this icon to display your profile. From this window, 
upload and share photos and files and set the privacy for 
shared items. 

 
Click this icon to properly log out of the ESS web portal. 

 

Menu Ribbon 

MENU  DESCRIPTION 

Home Home is the Welcome page and is the system default. 

Self Service 

The Self Service dropdown provides access to the following 
employee personal information: Profile, Time Off, Contract 
Acceptance, Documents, Coursework, Trainings, and HR 
Information. 

Pay/Tax Information 

The Pay/Tax Information dropdown provides access to the 
following employee Payroll Information: Employee Pay, 
Calendar Year Pay History, Total Compensation, Employee 
Tax Forms, and Employee W2. 

Benefits 

The Benefits dropdown provides access to the following: HR 
Benefits Enrollment, HR Enrollment Detail, and HR Employee 
Beneficiaries. The HR Benefits Enrollment and HR Enrollment 
Detail are ONLY available to districts who have purchased the 
Benefits module. 

Expense 
Reimbursements 

The Expense Reimbursement menu is a link that launches 
iVisions Web Portal Employee Expense Reimbursements. This 
menu item requires a separate license. 

My Workflow 
The My Workflow menu displays ONLY with proper access 
privileges (e.g., administrator, approver). 
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SELF SERVICE MENU 

Overview 

The Self Service menu of ESS provides access to personal information (e.g., profile, 

documents, HR info) currently on file at the district. Review and update personal 

information and perform tasks (e.g., submit vacation/absence requests and 

review/accept contract) via the web portal. 

In some situations, the last 4 digits of the employee Social Security 

Number are required to make changes. 

This section takes a closer look at each of the available Self Service menu resources. 

Profile 

Self Service > Profile 

The Profile resource allows employees to view/modify personal contact information 

on file with the district and to add/modify Emergency Contacts. 

Employee Profile 
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Activity (Optional) 

For the following activity, update Owen’s information using the scenario outlined in 

the following activity. 

Update Profile 

SCENARIO: In reviewing his personal information, Owen noticed his street address 

was not updated when he moved into his new home. Ensure you are logged in as 

omoney | v and update the profile. 

1. From the Self Service menu, select Profile. 

2. Beneath his profile information, click Modify. 

3. Enter the last 4 digits of Owen’s Social Security Number “4644”. 

4. Click Submit. 

5. Change his Mailing Address to “123 Green Road”. 

6. In the Effective Date field, type “8/6/20xx”. This date is the effective date 

of the change. If the field is left blank, the system uses the current date by 

default. 

7. Click Submit. 

Tyler suggests printing (File > Print) a copy for your records. 

 

8. Click Return. The Profile window displays. 

Changes display in the Pending Changes grid and route to HR/PR for processing. 

Once processed, the change no longer display in the Pending Changes grid. 

Emergency Contacts 

Self Service > Profile > Emergency Contacts 

The Emergency Contacts grid at the bottom of the Profile window displays the 

current emergency contacts on file with the district. View, update, and delete 

existing contact information or add a new contact as necessary by clicking the 

magnifying glass next to the contact to edit. The Edit Emergency Contact window 

displays. After making changes, click Update Contact or if the contact is no longer 

valid, click Delete Contact. 

Activity (Optional) 

It is important for the district to have accurate emergency contact information on 

file. Make sure to review, update, and add contacts as soon as things change. For 
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training purposes, walk through adding a new emergency contact using the scenario 

outlined in the following activity. 

Add an Emergency Contact 

SCENARIO: In reviewing his profile, Owen realized he has forgotten to add one of his 

closest friends as an emergency contact and wanted to take care of it immediately. 

1. Beneath the Emergency Contacts grid, click Add New Contact. 

2. In the First Name field, type “Del”. 

3. In the Last Name field, type “Monty”. 

4. In the Pri Phone field, type “5201234567”. It is not necessary to type the 

hyphens (-) as the number is automatically formatted. 

First Name, Last Name, and Pri. Phone are required fields and 

are denoted with a yellow light bulb. 

5. Click Add Contact to return to the original Profile window. The Emergency 

Contacts grid is updated to display the newly added contact. 

Time Off  

Self Service > Time Off 

The Time Off resource displays the Employee Leave Summary for all applicable leave 

plans published to the web portal. 

 
Employee Leave Summary  

From this window, employees can perform the following: Request Time Off and 

view My Requests. Request Time off displays the wizard to walk through the request 

process. My Requests allows an employee to view requests by filtering on Request 

Status (Denied, Pending, Processed, or Used). From this window, employees can 

delete a request and review the request approval log by clicking the appropriate 

icon to the right of the request. 

From the Employee Leave Summary window, employees can click the magnifying 

glass next to the leave plan to view Detail Leave Plan information.  
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Also, an employee can click the calendar icon to view their leave requests on a 

weekly/monthly calendar. Easily identify Leave Taken and submitted Leave Requests 

by the color noted in the legend. 

Activity (Optional) 

Submitting a time off request is easy. Using the Portal, employees can request leave 

from their computer or mobile devices at any time of the day or night. 

Submit a Leave Request 

SCENARIO: Owen is planning his annual family vacation to California. He is taking 5 

days of vacation during the second week of October and needs to submit his 

request for approval. 

A yellow light bulb denotes a required field which must be populated 

before clicking Submit. 

1. From the Self Service menu, select Time Off. 

2. Beneath the Leave Summary grid, click Request Time Off. The Request 

Time Off window displays. 

3. Using the Month arrows on the Select Dates tab, navigate to May 20xx.  

4. Select the days on the calendar, 5/20/20xx - 5/24/20xx, and click Next. 

5. On the Select Type tab, select Admin – Annual Leave - Days and click 

Next. 

6. On the Partial Day Requests tab, note the number of days requested. 

7. In the From Time/To Time fields, enter or select normal working hours as 

applicable or leave as default and click Next. 

8. On the Additional Information tab, type the absence reason (required). 

The Specific Use dropdown is not used for this leave type (this field is 

available only if specific use categories are used). 

9. In the Note field, type “I need a vacation.” 

10. Click Submit Request. A Summary window displays. 

11. Click Back. The Employee Leave Summary window displays. Below 

Absence Requests, the Pending Absence Requests grid is updated to 

display the newly submitted request. Once the request completes the 

approval process, the system automatically removes it from the grid.   
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 TIME OFF 

The Leave Plan Balances grid on the Detail Leave Information window for the 
applicable leave plan is updated to reflect the Pending Approval hours. 

The Employee Leave Request Modify grid is updated to display the submitted 
request. 

A request returned to the originator status displays Returned. 

Only requests with a Pending status can be canceled. 

Contract Acceptance 

Self Service > Contract Acceptance 

The Contract Acceptance module allows employees to view any contract(s) 

appended to their employee documents and published to the web portal. From the 

Select dropdown, choose the contract to view and then click View. As applicable, 

select accept/not accept the selected contract, add comments, and then click 

Submit. 

Activity (Optional) 

When HR publishes contracts to ESS, the employees may receive an email notifying 

them of the publication and to log in to the portal and either accept or deny the 

contract. 

Accept a Contract 

SCENARIO: HR notified Owen his Salaried Contract is available for acceptance in the 

portal. 

1. From the Select dropdown, choose SALARIED CONTRACT and click View. 

2. Read the Contract instructions. 

3. Mark the I accept this SALARIED CONTRACT checkbox. 

4. Click Submit. The Confirm SSN window displays. 

5. Type the last 4 digits of Owen’s SSN “4644”.  

6. The Contract has been Accepted message displays. 

If Owen had multiple contracts, he would repeat steps 1 - 6 for each contract. 

If the district has activated the Contract Received email alert (Security > 

Workflow Configuration > Email Jobs/Alerts), the employee is sent a 

confirmation email once they accept/reject their contract. 
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Documents 

Self Service > Documents 

The Document Center allows employees to view/print any published documents 

attached to their employee record. 

Review documents currently on file for Owen Money. 

HR Information 

Self Service > HR Information 

The HR Information resource allows employees to review personal information (e.g., 

certificates, endorsements, languages, dependents) they currently have on file at 

the business office. 

Review the different types of personal information. 

User Defined Forms 

Self Service > District Forms 

The User Defined Forms resource allows employees to access, create, save for the 

future, and submit district forms published (Infinite Visions > Security > Workflow 

Configuration > User Defined Forms) to the portal. 

Activity (Optional) 

An entity can define many User Defined Forms for employees to have access and 

complete online. The Forms, once submitted, can be routed to many different 

resources. 

Submit a Gifts and Donations Form 

SCENARIO: Owen previously started to fill out his Gifts and Donations form but was 

called away. Thankfully, he had saved the form. Now, he would like to complete and 

submit his donation. 

1. Click the pencil to the right of the Gifts and Donations Status Date to edit 

the form.  

2. Review the fields on the form. 

3. In the Dollar Value of the Gift or Donation field, type “300.00”. 

4. In the Date field, enter today’s date. 

5. Click Submit. The Status changes to Submitted. 
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Select the printer icon to print the form. 

Select the clipboard to review the approval log. 

REVIEW PAY TAX INFORMATION 

Overview 

The Pay/Tax Information menu of Employee Self Service provides access to personal 

payroll related information (e.g., Calendar to Date Earnings Statement, Total 

Compensation Statement, Tax Forms, and Employee W2) employees can review via 

the web. 

Employee Pay 

Pay Tax Information > Employee Pay 

The Employee Pay resource allows employees to view pay check information for the 

selected pay date/pay period.  It also provides a pay calculator utility. 

Activity (Optional) 

The pay check calculator utility is used to run “What If” scenarios to see how 

changes to taxes and deduction/benefit information could impact overall pay check 

totals. 

Calculate Pay Check Changes 

SCENARIO: Owen Money has recently married and is the proud father of a bouncing 

baby boy. He is planning to change his tax withholding information to reflect the 

new additions to his family. Before he submits a new W‐4 form to Payroll, he would 

like to see how these changes impact his current net pay. 

1. Review Owen’s current Net Pay amount. 

2. Scroll to the bottom of the Employee Pay page and click the Pay Check 

Calculator link. The Salary Calculator displays. 

3. From the Federal Filing Status dropdown, select Married. 

4. In the Federal Allowances field, type “2”. 

5. Scroll to the bottom of the page and click Calculate. 

6. Note Owen’s new Net Pay in the Results window. 

7. Close the Browser tab. 
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Direct Deposit 

Pay/Tax Information > Employee Direct Deposit 

The Direct Deposit resource allows employees to review any current direct deposit 

setup. From this window, submit new direct deposit requests. Until the request is 

approved/rejected pending changes cannot be edited. Once a DD request is 

submitted, payroll is notified by email and approves/rejects requests as appropriate.  

Employees are notified by email if their request is approved. Email alerts 

must be active (Infinite Visions > Security > Workflow Configuration > 

Email Alerts and Jobs). 

Activity (Optional) 

No longer do your employees have to go to the Business Office, fill out a direct 

deposit form, and give the PR clerk a copy of a voided check or deposit slip. They 

can submit their direct deposit information anywhere with Internet access. 

Submit a Direct Deposit Change 

SCENARIO: Owen would like to change the account where his net pay is deposited. 

1. Click Direct Deposit. 

2. Click Make Changes. 

3. Click Edit to the right of the existing Direct Deposit Net Pay record. The 

Edit Direct Deposit Information window displays.  

4. Review the Direct Deposit Information. 

5. Click Cancel to exit. 

6. Click Add New. 

7. Complete the following fields: 

FIELD NAME VALUE 

Deduction 
Direct Deposit 1 

Bank Name 
IV National Bank 

Routing Number 
123456789 

Confirm Routing Number 
123456789 

Account Number 
123456 
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FIELD NAME VALUE 

Confirm Account Number 
123456 

Account Type 
checking 

Amount 
100.00 

8. Click Choose File and navigate to C: > Infinite Visions > File Attachments > 

OMoney Deposit Slip and click Open to attach deposit slip. 

9. Click Save. 

10. Click Submit Changes to send the request to Payroll for approval. 

Global Direct Deposit preferences are configured in IVEE > PR > Payroll 

Default Settings > Direct Deposit tab > Portal Direct Deposit Settings. 

Calendar Year Pay History 

Pay/Tax Information > Calendar Year Pay History 

The Calendar Year Pay History resource displays a summary statement of Earnings, 

Employee Deductions, and Employer Paid Benefits for a specific year. In the Year 

field, enter the year to view and then click Show Statement. To print the statement, 

click the printer icon below the statement. The statement opens in a new browser 

window. Select File > Print.  

Employee Tax Forms 

Pay/Tax Information > Employee Tax Forms 

The Employee Tax Forms resource allows employees to review their current filing 

status and to submit changes to their tax withholding information. They also have 

access to Federal and State tax forms. 

Activity (Optional) 

Often, employees need to update their tax information due to life event changes. 

The portal simplifies this process. 

Submit a Tax Change 

SCENARIO: Previously, Owen used the Pay Calculator to see what changes occur 

when he updates his Federal Tax information. He has decided now is the time to 

enter and submit his updated W-4. 

1. Review Owen’s Current Elections. 
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2. Click the Click to Fill Out Tax Forms link. 

3. Click Let me choose. 

4. Click Federal W-4 Employee’s Withholding Allowance Certificate. 

5. Select Married and click Next. 

6. Owen is not exempt from Federal Withholding. Select No and then, click 

Next. 

7. Owen does not want to complete the Personal Allowances Spreadsheet. 

Select No and click Next. 

8. Owen is claiming 2 allowances. Type “2” and click Next. 

9. Owen does not want any additional amount taken out of each check. Type 

“0” and click Next. 

10. Mark the Under penalties of perjury statement checkbox and type “4644” 

as the last 4 digits of his SSN. 

11. Click Submit Form. 

12. Click Sign Out to exit the session. Click the X on the tab to close the 

window. 

Employee W2 

Pay/Tax Information > Employee W-2 

The Employee W2 resource allows employees to review, print, or save the most 

recent copy of their W2 generated by payroll. 

The W-2 exports as a PDF.  

Modules can be created to publish W-2s for multiple years.  

Do not create duplicate Pay/Tax pages.  

WORK WITH BENEFIT INFORMATION 

Overview 

The Benefits menu items HR Benefits Enrollment and HR Benefits items 

Detail are available only to districts who have purchased the Infinite 

Visions Benefits Enrollment Module. If your district purchased online 

Benefits Enrollment, separate training/resources would be made 

available to you. 
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ENTER EXPENSE REIMBURSEMENTS 

Overview 

The Expense Reimbursement menu is a link and launches the iVisions Expense 

Reimbursements module. 

The Expense Reimbursement menu is available only to districts who have 

purchased the Infinite Visions Expense Reimbursement Module. For 

more information, contact your IVEE Implementation Consultant. If your 

district purchased Expense Reimbursements, separate training/resources 

would be made available to you. 

ACCESS MY WORKFLOW 

Overview 

My Workflow menu is available only to users (e.g., administrators, approvers) 

assigned a security role in Administration with Workflow access. The following 

sections of this guide cover access to My Workflow.  

 SECTION SUMMARY 

In this section, we reviewed the Employee Self Service menu.  We also learned how 

to look up and update personal information in iVisions. 

In the next section, we work with the items in iVisions.  
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SECTION ASSESSMENT 

 

1. List 2 ways to access iVisions’ Employee Self Service. 

a. ________________________________ 

b. ________________________________ 

2. Required fields are denoted with a: 

a. Yellow light bulb  

b. Red flag 

c. Highlighted text 

d. None of the above 

3. For security purposes, iVisions may ask a user to enter: 

a. Their birth date 

b. Zip Code 

c. Last 4 digits of SSN  

d. Last 4 digits of Phone # 

4. What fields are required when adding an emergency contact. 

a. _____________________________ 

b. _____________________________ 

c. _____________________________ 

 

5. iVisions can display multiple years of W-2’s. 

a. True  

b. False 
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iVisions  

Introduction 

Employees, who are part of a predefined approval process access iVisions for items 

such as invoices, purchase requisitions, purchase orders, journal entries, hours 

entry, ePARs, and User Defined forms by clicking the My Workflow menu within ESS. 

From the My Dashboard page, a user has access to Tiles, Smart Cards, Smart Charts, 

their Profile, and the 9-Box. 

In the upcoming activities, we use several Capital City School District employees for 

demonstrating the functionality of iVisions.  

JOB TITLE USER ID | PASSWORD PERSONA 

Finance Director  Omoney | v Finance Director 

Superintendent Pabbott | v Superintendent 

Principal Hapeno | v Department Head 

Admin Assistant Bwire | v General User 

OMNI SEARCH BAR  

Overview 

The Omni Search Bar enables users to navigate quickly to their My Dashboard page, 

search globally within iVisions, access the 9-Box, and configure their iVisions User 

Profile.  

Log into iVisions as Hal Apeno (Principal of Capital City Elementary School). 

FIELD NAME VALUE 

User ID Hapeno 

Password v (lowercase) 

 

Section Topics 

• Search (Omni) Bar 

• Tile Shortcuts 

• SmartCards 

• SmartCharts 
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BUTTON DESCRIPTION 

 

Click the Talking Ts from anywhere within iVisions to 
return to the My Dashboard page. 

 

Enter text in the Search field to search the entire iVisions 
database. 

 

Click the 9-Box to displays menu icons. Click an icon to 
display the page within iVisions. Click More to display more 
icons. Click Show All to view ALL icons on a separate page. 

 

Click the Profile icon to configure My Profile settings and 
Sign Out of iVisions. 

Activities (Required) 

Global Search Navigation 

1. In the Global Search field, type “ABC School Supply.” 

2. Click the magnifying glass or press ENTER on the keyboard to search for 

ABC School Supply. iVisions will display a list of records matching the ABC 

School Supply search criteria. 

The navigation bar at the bottom of the page allows the user to 

navigate from page to page, return to the first or previous page, 

or select the next or last page. 

Menu headers separate module records. 

3. Single-click PO #240001 to expand the record. 

4. Click View Item to open the item in the Control Panel. 

5. From the Search Bar, click the Talking Ts to return to the My Dashboard 

page. 

9-Box Navigation 

1. From the Search Bar, click the 9-Box. 

2. Click More to expand the menu. 

3. Scroll to the bottom of the menu and click Show All to display all icons on 

a separate page. 

4. From the Search Bar, click the Talking Ts to return to the My Dashboard 

page. 



  

 

 IVISIONS ESS AND WORKFLOW 25 
IVISIONS 

  

Profile Navigation 

1. From the Search Bar, click the Profile icon. 

2. Click My Profile. 

3. Click Edit Photo to add a personalized photo. 

My Profile Fields:  

FIELD DESCRIPTION 

Edit Photo Click EDIT PHOTO to change a profile’s photo. 

Change Password 
If applicable, click CHANGE PASSWORD to enter 
Current Password and New Password. Click SAVE 
CHANGES to save the New Password. 

General Field: 

FIELD DESCRIPTION 

Connection Group 

From the Connection Group dropdown, select the 
profile’s default connection group. If no 
connection group is selected, the default is the 
connection group marked as Mobile Primary in 
Administration. 

After making a change on the Profile page, click SAVE at the bottom of 

the page. 

TILE SHORTCUTS  

Overview 

Several Personas display Tile shortcuts at the top of the My Dashboard Page.  

 

Example of Tile Shortcuts 

Tile Shortcuts displays Workflow Counts and provide quick access to frequently used 

menu items.  

Tile Shortcuts are system-defined and are not customizable. 
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SMART CARDS  

Overview 

Smart Cards display the user’s approval queue and important notifications. Only 

items requiring the user’s attention display as a Smart Card. For instance, if a user 

has warehouse requisitions to approve, a Smart Card displays on their My 

Dashboard page denoting the number of warehouse requisitions requiring their 

attention. Once the user approves all requisitions, the Warehouse Requisition Smart 

Card no longer displays. 

 

Example of Smart Card  

Activity (Required) 

Smart Card Navigation 

1. Single-click Warehouse Requisitions to view the warehouse requisitions 

requiring Hal’s approval. 

2. Review the approval commands on the right of the Smart Card. 

COMMAND DESCRIPTION 

 
Click this icon to Approve the requisition. 

 
Click this icon to Return the record to Prior Approver. 
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COMMAND DESCRIPTION 

 
Click this icon to Return the record to Originator. 

 
Click this icon to View a record’s Detail. 

 

Click this icon to send the record via email.  

This command opens an email window. 

3. Click the green checkmark to approve Requisition #31. The record no 

longer displays in the approval queue. 

4. Click Warehouse Requisitions to collapse the Warehouse Requisition 

Smart Card. 

SMART CHARTS  

Overview 

Smart Charts display data analytics. The Smart Charts displayed on the My 

Dashboard page is determined by the user’s assigned Persona. Barb’s Smart Charts 

consist of Open Purchase Orders by Requester and Open Requisitions by 

Departments, while Owen Money’s (assigned the Financial Director Persona) My 

Dashboard reveals a different set of Smart Charts. 

Some Smart Charts have configuration capabilities. Hover over the chart. If a cog 

displays in the upper right corner, the chart’s configuration is editable.  

 

Example of Smart Charts 
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Activities (Required) 

Single Smart Chart Configuration 

1. Click the configuration cog on the Monthly Expenditure Smart Chart to 

display the Configure Monthly Expenditure Chart window. 

2. From the Group dropdown, select OBJECT. 

3. Click Save Defaults to save the entry and return to the My Dashboard 

page. 

Multiple Smart Chart Configuration 

1. Click the Profile icon.  

2. Then, click My Profile to view all configurable Smart Charts. 

3. Make Chart changes as suggested by your instructor. 

4. Click Save. 

5. Click the Talking Ts to review chart changes. 

6. Click Profile.  

7. Click Sign Out. 

SECTION SUMMARY 

In this section, we learned how to navigate the My Dashboard page.  

In the next section, we review the different Tile Shortcuts, Smart Cards, and Smart 

Charts configured for each Persona. 
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SECTION ASSESSMENT 

 

1. Smart Cards only appear on the My Dashboard page if they require attention. 

a. True 

b. False 

2. Configure Multiple Smart Charts  

a. within Global Search 

b. within the 9-Box 

c. within My Profile  

d. None of the Above 

3. To approve a Requisition  

a. click the configuration cog 

b. click the green checkmark  

c. click the backward arrow 

d. None of the above 
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iVisions – General Ledger 

Introduction 

In the General Ledger module, look up detailed account and transaction 

information, run DEPARTMENT reports created in General Ledger Report Writer, 

and submit requests to change the budget. 

In the upcoming activities, we use several Capital City School District employees for 

demonstrating the functionality of iVisions.  

JOB TITLE USER ID | PASSWORD PERSONA 

Finance Director  Omoney | v Finance Director 

Superintendent Pabbott | v Superintendent 

Principal Hapeno | v Department Head 

Admin Assistant Bwire | v General User 

WORK WITH BUDGET JOURNAL ENTRIES 

9-Box > Budget Journal Entry 

Overview 

The Budget Journal Entry grid displays all journal entry requests. Use the filter 

criteria as needed to limit the number of records to display. From the grid, users can 

add, edit, or delete budget journal entries. A budget journal entry must be a two-

sided entry, and debits/credits must be in balance by fund before posting the 

request. 

Activity (Required) 

Use the Activity scenario below to walk through the process of adding a budget 

journal entry to transfer funds between accounts. 

 

Section Topics 

• Work with Budget 

Journal Entries 

• Lookup Account Detail 

• Enter Budget 

Information 

• Work with General 

Ledger Reports 
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Enter a Budget Journal Entry 

SCENARIO: Hal Apeno has run out of budget capacity in one of his school’s supply 

accounts and wanted to request a budget transfer. Log into iVisions as (hapeno | v). 

1. On the toolbar, click Add. The Add Budget Journal Entry window displays. 

Complete the journal entry header using the following: 

FIELD NAME FIELD VALUE 

G/L Date Use today’s date 

Memo 
Transfer Supply Budget from 
Function 100 to 300. 

Reference Budget Adjustment 

Budget Type Current Working Budget 

Budget Journal Type Adjustment 

Department 
Capital City Elementary 
School 

2. Enter the Journal Entry Detail to transfer funds from one supply account 

to the other using the following: 

ACCOUNT DESCRIPTION DEBIT CREDIT 

001.10.100.5410 Supplies – General $0.00 $1500.00 

001.10.300.5410 Supplies – General $1500.00 $0.00 

Remember to click the Save icon after completing each row of 

information.  

3. When finished entering lines, mark the Close after update? checkbox and 

click OK. 

4. Click the Talking Ts to return to the main menu. 
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 BUDGET JOURNAL ENTRY 

Only budget columns with the Use Journal checkbox marked are available for 
selection in the Budget Type dropdown. 

From the Add/Edit Journal Entry window, choose Manage Documents from the 
Actions menu to review, add, and edit JE attached documents. For Tyler 
Content Manager (TCM) users, the documents open in the TCM viewer. 

Only active accounts assigned in Security > User Security and are assigned 
DEPARTMENT Accounts with the Allow Budget Adjustments checkbox marked 
are available for selection in the Account dropdown. 

In 9-Box > Journal Entry Approval, a GL Site user can mark the Show All Journal 
Entry Requests checkbox to view all journal entries awaiting approval 
regardless of DEPARTMENT. User must have the Allow GL Approval Override 
checkbox marked (IVEE > Security > User Security > P&P Options tab). 

LOOK UP ACCOUNT DETAIL AND WORK WITH 
JOURNALS 

Overview 

Use these menu items to review account and journal detail. For users assigned to a 

DEPARTMENT with the General Ledger Site attribute (Security > Workflow 

Configuration > Distributed Accountability Centers), detail for all accounts is 

available. Otherwise, information is restricted to accounts assigned to the user or 

DEPARTMENT. To display specific accounts, select filter criteria as applicable and 

then click Apply Selection. 

Activity (Required) 

9-Box > Account Detail 

The following activity walks through the process of reviewing account detail 

information and transaction activity. 

Review Account Detail Activity 

SCENARIO: Hal Apeno wants to look up the transaction activity for one of the supply 

accounts his school uses on a frequent basis. 

1. In the Account Filter field, type “001.10.100.5410”. 

2. Click Apply. 

3. Double-click the record. The View Account Detail window displays. Review 

the transaction history. 

4. Click OK. 
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Account Detail displays as applicable on the following tabs: 

TAB DESCRIPTION 

Transaction Journal  

Displays all transactions for the selected account. If 
the account is payroll related, double-click in the Pay 
Cycle/Pay Period column to view payroll transaction 
detail for the specified period. 

Budget Journal 
Displays all budget journal entries or budget 
adjustment entries for the selected account. 

Purchase 
Encumbrance 

Displays all accounts payable transactions with 
current encumbrances for the selected account. 

Payroll Encumbrance 
Displays all payroll transactions with current 
encumbrances for the selected account. 

Notes 
Displays notes added for an account in General 
Ledger > Chart of Accounts > Account Code Input. 

5. Click the 9-Box to return to the main menu. 

Activity (Required) 

9-Box > Journal Detail 

Use the Journal Detail window to view account activity. In addition to the 

Transaction Journal, choose to review transactions for Budget Journal, Purchase 

Encumbrance, and Payroll Encumbrance. From the Actions menu, print a report of 

any of the following: 

TAB DESCRIPTION 

Transaction Journal  

Displays all transactions for the selected account. If 
the account is payroll related, double-click in the Pay 
Cycle/Pay Period column to view payroll transaction 
detail for the specified period. 

Budget Journal 
Displays all budget journal entries or budget 
adjustment entries for the selected account. 

Purchase 
Encumbrance 

Displays all accounts payable transactions with 
current encumbrances for the selected account. 

Payroll Encumbrance 
Displays all payroll transactions with current 
encumbrances for the selected account. 

Notes 
Displays notes added for an account in General 
Ledger > Chart of Accounts > Account Code Input. 
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Review Journal Detail Activity 

SCENARIO: Hal Apeno wants to look up the transaction activity for a CCES supply 

account. 

1. In the Account Filter field, type “001.10.100.5410”. 

2. Mark the Transaction and Purchase Encumbrance checkboxes. 

3. Click Apply. 

4. Review the information on the different tabs. 

5. Click the Talking Ts to return to the main menu. 

 JOURNAL DETAIL 

Use zeros in the Collapse Mask to roll up account detail. Change the view 
dropdown from Full to one of the other options. 

The Originator column displays in the grid only if approvals are enabled. 

If the Include Paid Pay Periods checkbox is marked, the grid displays records 
with a status of posted and unposted. If cleared, only unposted records display 
on the encumbrance tab. 

WORK WITH DEPOSIT MANAGER 

9-Box > Deposits 

Overview 

Use this program to work with deposit information. Using the filter criteria, display 

deposits for a specific bank account and a specified date range. 

Sign out of iVisions as Hal Apeno and log in as Barb Wire (bwire | v). 

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Reprint Deposit  
Select this command to reprint a selected deposit. 
A user cannot reprint cleared or voided deposits. 
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COMMAND DESCRIPTION 

Void Deposit 

Select this command to void an uncleared deposit. 
 
If working in the current fiscal year and a deposit 
from the prior year is selected to void, the 
following message displays: “This deposit was 
written is in a different fiscal year. Do you wish to 
mark the deposit voided and handle the journal 
entries manually?”. Click Yes to continue with the 
void. 

Manage Document 
Select this command to display any documents 
currently attached to the selected deposit. 

Archive Deposits Select this command to Archive Cleared Deposits. 

From the Add/Edit Deposit Ticket window, the following commands are available 

from the Actions menu: 

COMMAND DESCRIPTION 

Open  Select this command to open a saved deposit. 

Save for Later 
Select this command to save a partially completed 
deposit to finish later. 

Import Deposit Detail 
Select this command to import deposit detail from 
an Excel spreadsheet. 

Discard Deposit Select this command to delete the deposit. 

Activity (Required) 

The following activity walks through the process of adding a deposit for a received 

check. 

Add a Deposit 

SCENARIO: Johnny B Good checked out Stuart Little from the Library last school year 

and did not return it on the due date. His mother paid the overdue book fees with a 

check for $30.00. Add the deposit using the following information: 

1. From the Deposit Manager window, click Add. The Add Deposit Ticket 

window displays. 

2. Enter the deposit using the following information: 

FIELD NAME FIELD VALUE 

Bank Account 
National Bank Operating 
Account 
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FIELD NAME FIELD VALUE 

Date Use today’s date 

Memo 
Overdue Library Fee – 
Johnny B Goode 

Deposit No. Default 

Cash N/A 

Check $30.00 

Credit N/A 

Other N/A 

3. Verify the Print Deposit and Print Journal Entries checkboxes are marked 

and enter the following account detail: 

FIELD NAME VALUE 

Account 001.10.000.4140 

Description Overdue Library Fees 

Amount $30.00 

4. Click the Save icon. 

5. Verify the variance is $0.00. 

6. Mark the Close after update? checkbox and click OK to close. 

Marking the Allow posting of deposits to the general ledger 

checkbox on the Security > User Security > GL Security Options 

tab gives individual users rights to post deposits. 

Since Barb does not have rights to post deposits, this deposit is unposted. Another 

user must post the deposit. 

7. Click the 9-Box to return to the main menu. 
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ENTER BUDGET INFORMATION 

9-Box > Budget Input Using Definition 

Overview 

This budget option is used to input budget data and report budget data using the 

custom budget input definitions defined in Infinite Visions.  

Using a definition provides the ability to: 

• Work with more than 3 budget columns in a grid 

• Create comparison columns by dollar or percentage 

• Run GL Report Writer Budget reports using a definition 

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Column Total  
Select this command to quickly display a column 
total for any of the columns in the Budget Input 
Using Definition grid. 

Apply Factor to Selected Accounts 
Select this command to increase or decrease all 
accounts displayed on the grid by a specified 
factor. 

Activity (Required) 

iVisions allows administrators with permission to edit their budget. They cannot add 

or delete accounts within the Budget Input Using Definition grid.  

Let’s sign out as Barb and log in as Hal Apeno (hapeno | v). 

Edit Budget 

SCENARIO: Hal forgot to increase the budget to include Bill Board’s 6% pay raise.  

He has asked Barb to update Bill’s detail line on the budget. 

1. From the Budget Input Definition dropdown, select Budget Comparison 

NY 1.5% to Current Budget. 

2. Enter “001.10.100.5210” in the Account Filter and click Apply. 

3. Highlight Bill Board’s position and click . 

4. Change the amount from $6,847.87 to “$7,258.74.” 

5. Click Save. 

6. From the Actions menu, select Notes. Type “Increased Bill Board’s 

custodian position by 6%”. 
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7. Click OK. The Notes checkbox on the grid updates to display as marked. 

8. Click OK to close. Note the changes to the account in the grid. 

9. Click the 9-Box to return to the main menu. 

The Budget Input Using definition grid is a fixed grid; columns are not 

moveable. Tyler does not suggest saving the layout of this grid. 

BUDGET ADJUSTMENT ENTRY  

9-Box > Budget Adjustment Entry 

Overview 

The Budget Adjustment Entry grid displays all budget adjustment entry requests. A 

budget adjustment entry differs from a budget journal entry in a budget adjustment 

entry can be single-side (debits/credits do not have to balance to be posted). 

Activity (Required) 

The following activity walks through the process of how to add a budget journal 

adjustment to increase an account budget. 

Enter a Budget Adjustment 

SCENARIO: Hal has run out of budget capacity in two of his school’s warehouse 

supply accounts and wants to request a budget increase. Barb will enter the changes 

for him. 

Enter the following: 

FIELD NAME FIELD VALUE 

G/L Date Use today’s date 

Memo 
Increase WHS Supply Budget 
Capacity 

Reference Budget Adjustment 

Budget Type Current Working Budget 

DEPARTMENT 
Business and Finance 
Services 
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1. Click Add on the tool bar. The Add Budget Journal Entry window displays. 

Enter the following detail: 

ACCOUNT DESCRIPTION DEBIT CREDIT 

001.10.200.5419 Warehouse Orders $500.00 $0.00 

110.10.300.5419 Warehouse Orders $400.00 $0.00 

APPROVE BUDGET ADJUSTMENTS 

Smart Card  or 9-Box > Budget Adjustments 

Overview 

The Budget Adjustments menu item is shown only to users designated as an 

approver for budget adjustments. The Budget Adjustments grid displays any budget 

journal adjustments waiting to be approved. In the grid, double-click a record to 

view adjustment detail. 

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Return to Originator  
Select this command to return the request to the 
person who created the adjustment. 

Return to Prior Approver 
Select this command to return the request to the 
last person who approved it. 

Approve Entry 
Select this command to approve the requests in 
the grid with the Process checkbox marked. 

Activity (Required) 

The following activity walks through the process on how to approve budget 

adjustment entries. 

Approve Budget Adjustment 

1. Log in as hapeno | v 

2. Click Budget Adjustments under 9-Box. 

3. In the Budget Adjustments grid, mark the Process checkbox for all 

requests to approve. 

4. From the Actions menu, select Approve Entry. Upon successful 

completion, the marked requests disappear from the grid, and the 

Approval Log is updated. 
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If necessary, before approving an entry, review the account budget by 

double-clicking the journal entry. The View Budget Journal Entry window 

displays. Double-click an account in the grid or select an account and 

press CTRL + B on the keyboard. 

WORK WITH GENERAL LEDGER REPORTS 

GL Report Writer 

9-Box > GL Report Writer 

Overview 

The grid displays any defined report templates. Add, edit, and delete reports as 

needed. 

A user assigned to a General Ledger Central Site Department can view 

and edit all reports regardless of the Department they are assigned. If 

the user is not assigned to a General Ledger Central Site Department, 

access control is created by the Report Manager. 

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Copy Report 
Select this command to copy the selected report 
in the grid. The copied report displays in the grid 
with “Copy of” in the Report Name. 

Copy Report to Next Fiscal Year 

Select this command to copy the selected report 
to the next fiscal year (if one exists). The report 
displays in the new fiscal year General Ledger 
Report grid with “Copy of” in the Report Name 

inkPrint Selected Reports 

Select this command to print the highlighted 
report(s). Specify the date range for records to 
include in the report and whether to include 
detail and budget adjustments. 

Create Grid 
Select this command to create a grid to export to 
Excel. Select the date range for records to include 
and whether to include Pre Encumbrances. 

Activity (Required) 

The following activity walks through the process of how to run a report to review 

data for a specified date range. 
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Run GL Report 

SCENARIO: Hal Apeno is concerned his school, Capital City Elementary, is getting 

close to overextending the supply budget. Run the supply budget report from 7/1/xx 

through 12/31/xx and check out the numbers. 

1. Filter for Capital City Elementary School and click Apply. 

2. Highlight Capital City Elementary Supply Report. 

3. From the Actions menu, select Print Selected Report(s). 

4. In the From Date field, type “7/1/20xx”. 

5. In the To Date field, type “12/31/20xx”. 

6. Click OK. The report generates as a PDF. 

7. Close the GL Report Writer tab to return to the General Ledger Report 

window. 

Monthly Expenditures are also available as a Smart Chart on the My 

Dashboard page. 

Activity (Required) 

The following activity explains the process for scheduling and sharing a report to run 

during a specific time frame. 

Schedule a GL Report 

SCENARIO: Owen wants to schedule the Capital City Elementary Supply Report to 

run every month for Hal Apeno, Peter Abbott, and their Board President, John 

Hancock. 

1. Log in as Omoney | v. 

2. In the grid, highlight Capital City Elementary Supply Report. 

3. From the Actions menu, select Print Selected Report(s). 

4. Mark the Schedule Report checkbox and click OK. The Schedule Report 

window displays. 

5. In the Schedule Start Date field, type “7/1/20xx”. 

6. In the Schedule End Date field, type “7/31/20xx” (with the year 2 years 

from now). 

7. From the Frequency dropdown, select Weekly. 

8. Mark the CYTD and Last Full Week checkbox. 

9. From the Share with dropdown, select Hapeno and Pabbott. 
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10. In the Email Recipients window, type “Jhancock@ccsd.k12.iv.us”. 

11. Click OK to exit. 

Before the system sends out the reports the Create Report Server Job 

utility must be run in IVEE > Security > Workflow Configuration > Email 

Settings > Actions > Create Report Server Job. 

Activity (Required) 

9-Box > Report Deliveries 

There are 2 ways to access a scheduled report. Internal users can access a report 

from the Report Deliveries icon while external users access the report from a link 

embedded in an email. 

Accessing a Scheduled Report Internally 

SCENARIO: Peter Abbott needs to review the Salaries and Benefits report Owen has 

scheduled to run weekly for him.   

1. Log in as Pabbott with the password “v” (lowercase). 

2. Click Report Deliveries. All scheduled reports display in the grid. 

3. Highlight the Salaries and Benefits report. 

4. From the Actions menu, select View Report. 

Using the Actions commands, users can email recipients outside their 

entity using the Email Recipients box. The recipient receives a link to the 

report in the body of the email. Alternatively, users can share the report 

with any employee with an Email address in Employee Maintenance. 

BUDGET CONTROL GROUP REPORTING 

9-Box > Control Group Reporting 

Overview 

Select this report option to generate a report summarized by budget control group. 

If the user is assigned to a Department with the General Ledger Central 

Site attribute, they can select any Department for the report. Otherwise, 

reports are limited to their Department only. 
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SECTION SUMMARY 

In this section, we reviewed the detailed account and transaction information, ran 

DEPARTMENT reports created in General Ledger Report Writer, submitted and 

approved requests to change the budget. 

In the next section, we learn how to add, edit, and print requisition and purchase 

order information for the DEPARTMENT. We also find out how to receive against 

Purchase Orders.  
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SECTION ASSESSMENT 

 

1. Only budget columns with the Use Journal checkbox marked are available for 

selection in the Budget Journal Entry Budget Type dropdown. 

a. True  

b. False 

2. By default, any user can post deposits. 

a. True 

b. False  

3. In Budget Input Using Definitions, DEPARTMENT users can only edit account 

code detail. 

a. True  

b. False 

4. Reports can only be scheduled to run monthly. 

a. True 

b. False  
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 IVISIONS ESS AND WORKFLOW 47 
IVISIONS – PURCHASING AND PAYABLES 

 

 

iVisions – Purchasing and 

Payables 

Introduction 

The Purchasing and Payables module allows users to add, edit, and print requisition 

and purchase order information for the DEPARTMENT. Also, users can receive 

against purchase orders. 

THE PURCHASING CONTROL PANEL 

9-Box > AP Control Panel 

Overview 

The Purchasing Control Panel provides an overview of the purchase order and 

requisition information. Access to information and to purchasing functionality is 

based on DEPARTMENT and assigned user role. 

In the Control Panel window, enter/select filter criteria as needed and then click 

Apply to limit the number of records to display in the grid. From the control panel, 

users can add, edit, view, and delete records.  

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Copy Requisition/PO 

Select this command to copy the selected 
requisition based on DEPARTMENT Budget 
Control options in Security > Workflow 
Configuration > Distributed Accountability 
Centers. 

Copy Requisition/PO to Next Year 

Select this command to copy the selected 
requisition to the next fiscal year, if one exists. 
This command is only available if the user has the 
Allow Req/PO Copy to Next Year checkbox 
marked in Security > User Security > P&P Security 
Options tab. This command can be used if the 
connection group is read only. 

Section Topics 

• The Purchasing 
Control Panel 

• Add a Requisition 

• Approve Purchase 
Requisitions 

• Print Requisitions 

• Approve Purchase 
Orders 

• Print Purchase 
Orders 

• Receive Against 
Purchase Orders 

• Vendor 
Maintenance 

• Purchasing and 
Payables Reports 
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COMMAND DESCRIPTION 

Print PO Pay History 

Select this command to print a pay history report 
for the selected record in the grid. A prompt 
message displays. Select one of the following: 
Open – Select this option to open, review, and 
print the report. 
Save – From the dropdown select one of the 
following: 
Save – Select this option to save the report to the 
system default Downloads folder. 
Save as – Select this option to display the Save As 
directory to navigate to the destination for the 
saved file. 
Save and Open – Select this option to save the 
report to the system default Downloads folder 
and open the report in the window. 
Cancel – Select this option to return to the grid. 

Approval Log 
Select this command to display the Approval Log 
for the selected record in the grid. 

Manage Documents 
Select this command to view, add, or delete 
document attachments for the highlighted record 
in the grid. 

Shortcuts 

Select this command to access links to Purchasing 
and Payables menu items (Vendor Maintenance, 
Projects, Requesters, Purchase Requisitions, and 
Purchase Order Approval). 

ADD A REQUISITION 

Overview 

From the control panel window, add a new requisition by clicking Add on the tool 

bar. The Add Requisition window displays. 

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Split Fund 
Select this command to split the item cost across 
multiple funds. 

Copy Line 
Select this command to copy the highlighted 
requisition line item in the grid. 

Recalculate Tax and Freight 

Select this command to recalculate tax and/or 
freight amounts based on percentages. The 
system recalculates amounts multiplying the Ext 
Price for each line item by the percentage and 
then applies the amounts for each item. 
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COMMAND DESCRIPTION 

Distribute Tax and Freight 

Select this command to distribute tax and/or 
freight by the flat dollar amount entered. The 
Extended Price is divided by the requisition 
subtotal to determine line percentage. The 
percentage is multiplied by the dollar amount 
entered. The system recalculates and distributes 
new amounts to each funding line. 

Apply Discount 
Select this command to apply a percentage 
discount to all requisition line items. 

Import from Excel 
Select this command to select an Excel file 
containing requisition line detail to import. 

Validate Requisition 

Select this command to check if all field entry has 
been completed and is valid before saving the 
requisition. If valid, the system displays a 
“Requisition is valid” message at the top of the 
window (displays for approx. 10 seconds). 

Check Budget 

Select this command to check the budget for 
accounts used in the requisition before saving. If 
an account is over budget, the Check Budget 
window displays for review. If there are no budget 
issues, the system displays a “Requisition is within 
budget limits” message at the top of the window 
(displays for approx. 10 seconds). 

Vendor Website 

Select this command to launch the vendor 
website (a valid web address must be entered in 
Purchasing and Payables > Vendors > Vendor 
Maintenance). If there is no web address entered, 
the system displays a “Vendor does not have a 
website on file” message at the top of the window 
(displays for approx. 10 seconds). 

E-Shopping 
If the district has purchased the optional E-
Procurement interface, select this command to 
launch the vendor’s website or hosted catalog. 

Accept Proposed Vendor 

Select this command to accept the requisition’s 
proposed vendor. Once accepted, the Proposed 
Vendor tab no longer displays, and a vendor 
record is created/saved in Vendor Maintenance. 

Insert Warehouse Items 
Select this command to display the Add 
Warehouse Items window to select the items to 
add to the requisition. 

Single Line Entry 

Select this command to open another Add 
Requisition window to enter a single requisition 
line item and to specify how funding is to be 
distributed. 

Manage Documents 
Select this command to view documents attached 
to the requisition. 
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From the Single Line Entry window, the following commands are available from the 

Actions menu: 

COMMAND DESCRIPTION 

Distribute on % 

Select this command to distribute a quantity of 
items ordered across multiple funding lines based 
on the percentage entered for each funding 
account. 

Distribute on $ 

Select this command to distribute a quantity of 
items ordered across multiple funding lines based 
on the dollar amount entered for each funding 
account. The Total Amount to apply field must be 
zero before saving 

Vendor Web Site 

Select this command to launch the vendor 
website (a valid web address must be entered in 
Purchasing and Payables > Vendors > Vendor 
Maintenance). If there is no web address entered, 
the system displays a “Vendor does not have a 
website on file” message at the top of the window 
(displays for approx. 10 seconds). 

 

 REQUISITIONS 

All required fields must be entered before saving requisition. If required 
information is missing, the required field name displays in bold red print and 
the field is outlined. 

After entering a detail line item, click the Save button before entering the next 
item. 

If an approval process is in place, mark the Submit for Approval checkbox. After 
clicking OK, the requisition begins routing through the defined approval 
process. 

Activity (Required) 

The following Add Requisitions activity walks through several requisitions which 

introduce a variety of different functions. 

Add Requisitions 

Before adding the requisition, be sure to read the processing instructions and 

perform the tasks as applicable.  

Log in as Bwire | v to enter the following requisitions: 
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REQUISITION 1 
Processing Instructions 
• None 

 

1. In the Control Panel window, click Add on the tool bar The Add Requisition window displays. On the Requisition 

Detail tab, complete the header information as follows: 

REQUISITION INFORMATION ORDER INFORMATION PO INFORMATION 

Req. Number: 1 Date: 10/01/20xx Order Via: Phone PO Number:  

Vendor: Walmart –Store 235 Project: None PO Date:  

Ship To: Capital City SD Main Warehouse Date Required:  Revisions:  

DEPARTMENT: Capital City Elementary School Order Type: Blanket Req App:  

Requester: Mandy Lifeboats Reference:  Closed Date:  

Buyer:  Award Number:  Status:  

2. In the grid, add the following line items (Click the Save icon after entering each line item.): 

Account Qty Unit Part No. Description Unit Price Ext Price Tax Freight Line Total 

001.10.200.5410 1 EA 

 

 Art Fair Supplies not to exceed $171.00 $150.00 $ 150.00 $10.50 $10.50 $ 171.00 

        

 

  

          

          

          

          

      $ 150.00 $  10.50 $  10.50 $171.00 

PO Notes (Notes tab): Please deliver supplies directly to Capital City Elementary School. 
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REQUISITION 2 
Processing Instructions 
• In the Requester field, type “Adam Baum.”  

 
After entering a name and then pressing TAB, the following message displays: “XX (where XX is the name 
of person) does not exist in the list of Requesters. Would you like to add “XX” to the list of Requesters?” 
Click OK to acknowledge message and continue. This utility is only available if the Allow Auto-add 
Requesters in iVisions checkbox is marked in IVEE > Purchasing & Payables > Configuration > Purchasing 
and Payables Default Settings. 

1. In the Control Panel window, click Add on the tool bar. The Add Requisition window displays. On the Requisition 

Detail tab, complete the header information as follows: 

REQUISITION INFORMATION ORDER INFORMATION PO INFORMATION 

Req. Number: 2 Date: 10/04/20xx Order Via: Mail PO Number:  

Vendor: Ace Handyman Services Project: None PO Date:  

Ship To: Capital City SD Main Warehouse Date Required:  Revisions:  

DEPARTMENT: Capital City Elementary School Order Type: Purchase Order Req App:  

Requester: Adam Baum Reference: SVCS Closed Date:  

Buyer:  Award Number:  Status:  

2. In the grid, add the following line items (Click the Save icon after entering each line item.): 

Account Qty Unit Part No. Description Unit Price Ext Price Tax Freight Line Total 

001.10.100.5710 1 EA 

 

 Removal of tree stump –Jan 27 storm $800.00 $ 800.00   $ 800.00 

        

 

  

          

          

          

          

          

          

      $ 800.00 $   0.00 $   0.00 $800.00 
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REQUISITION 3 

Processing Instructions 

• After entering the line item, review the budget warning message. 

• Change the Quantity field to “4”. 

 

1. In the Control Panel window, click Add on the tool bar The Add Requisition window displays. On the Requisition 

Detail tab, complete the header information as follows: 

REQUISITION INFORMATION ORDER INFORMATION PO INFORMATION 

Req. Number: 3 Date: 10/04/20xx Order Via: Phone PO Number:  

Vendor: Computer Supply Company Project: None PO Date:  

Ship To: Capital City SD Main Warehouse Date Required:  Revisions:  

DEPARTMENT: Capital City Elementary School Order Type: Purchase Order Req App:  

Requester: Mandy Lifeboats Reference:  Closed Date:  

Buyer:  Award Number:  Status:  

2. In the grid, add the following line items (Click the Save icon after entering the line item.): 

Account Qty Unit Part No. Description Unit Price Ext Price Tax Freight Line Total 

001.10.100.5410 400 EA 

 

324868 Computer Desk $250.00 $100,000.00   $100,000.00 

        

 

  

          

          

          

          

          

          

          

      $100,000.0
0 

$   0.00 $   0.00 $100,000.00 

PO Notes (Notes tab): 
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REQUISITION 4 

Processing Instructions 

• When entering line detail, mark the Hold Account checkbox.  

• Select Distribute Tax and Freight from the Actions menu. 

• Mark the Tax checkbox and enter $0.00. 

• Mark the Freight checkbox and enter $0.00. 

 

1. In the Control Panel window, click Add on the tool bar The Add Requisition window displays. On the Requisition 

Detail tab, complete the header information as follows: 

REQUISITION INFORMATION ORDER INFORMATION PO INFORMATION 

Req. Number: 4 Date: 10/04/20xx Order Via: Email PO Number:  

Vendor: Best Office Supply Project: None PO Date:  

Ship To: Capital City SD Main Warehouse Date Required:  Revisions:  

DEPARTMENT: Capital City Elementary School Order Type: Purchase Order Req App:  

Requester: Al Fresco Reference:  Closed Date:  

Buyer:  Award Number:  Status:  

2. In the grid, add the following line items (Click the Save icon after entering each line item.): 

Account Qty Unit Part No. Description Unit Price Ext Price Tax Freight Line Total 

 400.10.100.6300 3 EA 

 

84374 Office Chair, Blue $52.00 $ 156.00   $ 156.00 

400.10.100.6300 4 EA 85375 Office Chair, Red $52.00 $ 208.00  

 

 $ 208.00 

400.10.100.6300 2 EA 85210 Desk, Oak 30” x 60” $500.00 $1,000.00   $1,000.00 

400.10.100.6300 10 EA 85437 Desk Lamp, Fluorescent $18.57 $ 185.70   $ 185.70 

          

          

          

          

          

      $1,549.70 $   0.00 $   0.00 $1,549.70 

PO Notes (Notes tab): 
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REQUISITION 5 

Processing Instructions 

• None 

 

1. In the Control Panel window, click Add on the tool bar The Add Requisition window displays. On the Requisition 

Detail tab, complete the header information as follows: 

REQUISITION INFORMATION ORDER INFORMATION PO INFORMATION 

Req. Number: 5 Date: 10/04/20xx Order Via: www PO Number:  

Vendor: Computer Supply Company Project: None PO Date:  

Ship To: Capital City SD Main Warehouse Date Required:  Revisions:  

DEPARTMENT: Capital City Elementary School Order Type: Purchase Order Req App:  

Requester: Mandy Lifeboats Reference:  Closed Date:  

Buyer:  Award Number:  Status:  

 

2. From the Actions menu, select Import from Excel. 

3. Click Select. Navigate to C:\InfiniteVisions\File Attachments and double-click Requisition – Books.xls. 

4. Click Upload. Wait for the records to import. If records with invalid accounts are detected, the records are not 

imported. A window displays listing the accounts. Review the listing, and then click Close. 
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REQUISITION 6 

Processing Instructions 

• From the Actions menu, select Distribute Tax and Freight. 

• Mark the Tax checkbox and type “$0.00”. 

• Mark the Freight checkbox and type “$4.30”. 

 

1. In the Control Panel window, click Add on the tool bar. The Add Requisition window displays. On the Requisition 

Detail tab, complete the header information as follows: 

REQUISITION INFORMATION ORDER INFORMATION PO INFORMATION 

Req. Number: 6 Date: 10/04/20xx Order Via: Phone PO Number:  

Vendor: ABC School Supply Project: None PO Date:  

Ship To: Capital City SD Main Warehouse Date Required:  Revisions:  

DEPARTMENT: Capital City Elementary School Order Type: Purchase Order Req App:  

Requester: Mandy Lifeboats Reference:  Closed Date:  

Buyer:  Award Number:  Status:  

2. In the grid, add the following line items (Click the Save icon after entering each line item.): 

Account Qty Unit Part No. Description Unit Price Ext Price Tax Freight Line Total 

001.10.100.5410 3 EA 

 

P1800 Paper, Blue $3.37 $  10.11   $  10.11 

001.10.100.5410 2 EA P356 Envelopes $12.75 $  25.50  

 

 $  25.50 

001.10.100.5410 2 EA P914 Chalk Eraser $3.95 $   7.90   $   7.90 

          

          

          

          

          

          

      $  43.51 $   0.00 $   0.00 $43.51 

PO Notes (Notes tab): 
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REQUISITION 7 

Processing Instructions 

• After entering the requisition, double-click the record in the grid. The Edit Requisition window displays. 

• From the Actions menu, select Recalculate Tax and Freight. 

• Mark the Tax checkbox and enter “$0.00”. 

• Mark the Freight checkbox and enter “$0.00”. 

 

1. Enter the Requisition Information. 

2. From the Control Panel Actions menu, select Single Line Entry. Enter the Description, Part No., and Unit Price. 

3. From the Actions Menu select Distribute on $.  

4. In the Quantity field, type “4”. 

5. In the Account and Extended Price fields, enter the amounts for the items below. Click Save after each line 

entry. 

6. Click OK to exit.  

REQUISITION INFORMATION ORDER INFORMATION PO INFORMATION 

Req. Number: 7 Date: 10/04/20xx Order Via: www PO Number:  

Vendor: Computer Supply Company Project: None PO Date:  

Ship To: Capital City SD Main Warehouse Date Required:  Revisions:  

DEPARTMENT: Capital City Elementary School Order Type: Purchase Order Req App:  

Requester: Mandy Lifeboats Reference:  Closed Date:  

Buyer:  Award Number:  Status:  

 

Account Qty Unit Part No. Description Unit Price Ext Price Tax Freight Line Total 

001.10.100.5410 1 EA 

 

201541 File Cabinet $135.00 $ 135.00   $ 135.00 

001.20.100.5410 3 EA 201541 File Cabinet $135.00 $405.00   $405.00 

          

          

      $ 540.00 $   0.00 $   0.00 $ 540.00 
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PO Notes (Notes tab):  

 

REQUISITION 8 

Processing Instructions 

• After entering the requisition, double-click the record in the grid. The Edit Requisition window displays. 

• From the Actions menu, select Distribute Tax and Freight. 

• Mark the Tax checkbox and type “$36.80”. 

• Mark the Freight checkbox and type “$0.00”. 

 

1. Enter the Requisition Information. 

2. From the Control Panel Actions menu, select Single Line Entry. Enter the Description, Part No, and Unit Price. 

3. From the Actions menu, select Distribute on %.  

4. In the Quantity field, type “1”. 

5. Enter the Account and Percent for the items below. Click Save after each line entry. 

6. Click OK to close window and mark close after update?  

7. Click OK to exit. 

REQUISITION INFORMATION ORDER INFORMATION PO INFORMATION 

Req. Number: 8 Date: 10/04/20xx Order Via: www PO Number:  

Vendor: Best Office Supply  Project: None PO Date:  

Ship To: Capital City SD Main Warehouse Date Required:  Revisions:  

DEPARTMENT: Capital City Elementary School Order Type: Purchase Order Req App:  

Requester: Mandy Lifeboats Reference:  Closed Date:  

Buyer:  Award Number:  Status:  

 

Account Qty Unit Part No. Description Unit Price Ext Price Tax Freight Line Total 

001.10.100.5410 .5 EA 

 

311541 Shredder $400.00 $400.00   $400.00 

001.20.100.5410 .5         

          

          

      $400.00 $   0.00 $   0.00 $436.80 
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PO Notes (Notes tab):  

 

Activity (Required) 

From the control panel, a user can attach a related document to the selected 

requisition in the grid. Also, the user can view and delete any existing attachments. 

Add a Document Attachment 

SCENARIO: A spreadsheet listing the computers to order is saved on the computer 

and needs to be attached to the purchase requisition and sent to the vendor. 

 On the Control Panel grid, highlight Req No. 119 to Computer Supply 

Company. 

 From the Actions menu, select Manage Documents. The Manage 

Requisition Documents window displays. 

 From the Doc Type dropdown, select Requisition Attachments. 

 In the Notes field, type “See attached for computer order”. 

 Mark the Send Document checkbox to email the attached document to 

Computer Supply Company. The vendor must have a valid email address 

entered in the PO Email field in Purchasing & Payables > Vendors > Vendor 

Maintenance. 

 Click the paperclip at the end of the line. The Get Attachment window 

displays. 

 Click Select. Browse to C:\InfiniteVisions\File Attachments and double-click 

the Requisition – Computers document. 

 Click Upload. The document displays in the Manage Requisition Documents 

grid. The File Name and File Type field are updated to display the document 

name and document type extension (docx, pdf, etc.). 

 Click the red x to close the window and return to the Control Panel grid. 
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 MANAGE DOCUMENTS 

The Has Documents column in the Control Panel grid displays Yes if the record 
has documents attached. 

The Edit Requisition window displays a paper clip icon denoting there are 
documents attached to the record. Click the paperclip. The Manage Requisition 
Documents window displays. Manage Documents is also accessible from the 
Actions menu. 

The Has Documents column in the Control Panel grid displays Yes if the record 
has documents attached. 

The Edit Requisition window displays a paper clip icon denoting there are 
documents attached to the record. Click the paperclip. The Manage Requisition 
Documents window displays. Manage Documents is also accessible from the 
Actions menu. 

APPROVE PURCHASE REQUISITIONS 

9-Box > Requisition Approval 

Tiles > Requisitions 

Smart Cards > Requisition Approvals (Note: Smart Cards are used for Quick Approval) 

Overview 

If you are part of a defined requisition approval process, it is necessary to routinely 

process any requisitions waiting for your approval. This assures the requisitons 

continue to move through the approval process. 

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Check Budget 

Select this command to check the current budget 
status of accounts used on the requisition before 
approving. If any accounts exceed budget, a 
report displays. 

Check Vendor Alerts 
Select this command to review vendor alerts 
defined in IVEE > Security > Workflow 
Configuration > Email Alerts and Jobs. 

Show Vendor Alerts in Grid 
Select this command to display the vendor alert 
message in the grid. 

View Requisition 
Select this command to view the selected 
requisition detail in another window. 

Approval Log 
Select this command to view the approval log 
listing all approvers in the approval process for 
the selected requisitions. 
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COMMAND DESCRIPTION 

Return to Originator 
Select this command to return the selected 
requisition to the originator. 

Approve Requisition 
Select this command to bypass all remaining 
approvers in the approval process and route the 
requisition directly to Accounts Payable. 

Quick Approval 
Select this command to bypass all remaining 
approvers in the approval process and route the 
requisition directly to Accounts Payable. 

Alternate Approvers 
Select this command to add Alternate Approvers 
directly from iVisions Online Workflow rather 
than having to go to IVEE > Security > Approvers. 

Shortcuts  
Select this command to access the Control Panel, 
Print Requisitions, and Purchase Order Approval 
menu items. 

 

Follow the steps below to approve requisitions: 

 Log in as New User hapeno | v 

 On the Purchase Requisition grid, mark the Process checkbox for the 

requisition(s) to approve. 

 From the Actions menu, select Approve Requisition. The Approver field 

updates to display the name of the next approver. 

 Click OK to acknowledge message. 

It is necessary to approve the requisition twice if a user is the originator 

of the requisition as well as an approver in the defined approval process. 

APPROVE PURCHASE REQUISITIONS 

9-Box > PO Approval 

Tiles > Purchase Orders 

Smart Cards > Requisition Ready to Issue Purchase Orders (Note: Smart Cards are 

used for Quick Approval) 

Overview 

If the user is designated as an approver for purchase orders, the user has access to 

the Purchase Order Approval workflow menu item. From the grid, review the 

requisitions routed completely through the approval process and are ready to turn 

into a PO. 

From the Actions menu, the following commands are available: 
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COMMAND DESCRIPTION 

Check Budget 

Select this command to check the current budget 
status of accounts used on the requisition before 
approving. If any accounts exceed budget, a 
report displays. 

Check Vendor Alerts 
Select this command to review vendor alerts 
defined in IVEE > Security > Workflow 
Configuration > Email Alerts and Jobs. 

Show Vendor Alerts in Grid 
Select this command to display the vendor alert 
message in the grid. 

View Requisition 
Select this command to view the selected 
requisition detail in another window. 

Approval Log 
Select this command to view the approval log 
listing all approvers in the approval process for 
the selected requisitions. 

Return to Originator 
Select this command to return the selected 
requisition to the originator. 

Return to Prior Approver 
Select this command to route the record(s) in the 
grid with the Process checkbox marked back to 
the prior approver. 

Create PO 

Select this command to create a PO for the 
record(s) in the grid with the Process checkbox 
marked. Once the PO is created, the record is 
removed from the Purchase Order Approval grid. 

Shortcuts  
Select this command to access the Purchasing 
Control Panel, Print Requisitions, Print Purchase 
Orders, and Vendor Maintenance menu items. 

 

APPROVE PURCHASE REQUISITIONS 

9-Box > Print Purchase Orders 

Overview 

This menu item is used to print copies of purchase orders. Select filter criteria as 

needed and then click Apply. 

If the user is not assigned to a Central APDepartment, the Department 

field defaults with the name of their Department. PO viewing is limited to 

their Department only. 

 

From the Actions menu, the following commands are available: 
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COMMAND DESCRIPTION 

View Requisition 

Select this command to display the Purchase 
Requisition for the highlighted record. A popup 
displays. Choose one of the following: 
Open – Click this button to open and view the 
purchase requisition. From the purchase 
requisition window, print the report or attach it to 
an email. 
Save – From the dropdown, choose one of the 
following: 

Save – Select this option to save the 
purchase requisition to the system 
default Downloads folder. 
Save As – Select this option to display the 
Save As directory to navigate to the 
destination for the saved file. 
Save and Open – Select this option to 
save the purchase requisition to the 
system default Downloads folder and 
open the purchase requisition window. 
Cancel – Select this option to return to 
Print Purchase Orders grid. 

Manage Documents 
Select this command to view, add, or delete 
document attachments for the highlighted record. 

Print Purchase Order(s) 
Select this command to display the Print Purchase 
Order window. Mark the copies to print and select 
print options. 

 

 PRINT PURCHASE ORDERS 

If the Email Vendor Copy checkbox is marked, a valid email address must be 
entered in Purchasing & Payables > Vendors > Vendor Maintenance for the 
system to automatically send the email. Otherwise, a vendor copy is printed. 
The same applies if the Email Originator checkbox is marked. A valid email 
address must be entered in Payroll > Employees > Employee Maintenance. 

If Email Vendor Copy is marked, a note to include in the email can be added in 
the PO Email Options Note field in Purchasing & Payables > Configuration > 
Purchasing and Payables Default Settings. 

If the Mark as Printed checkbox is marked, the system updates the Printed 
column on the grid. 

If the Email Vendor Copy checkbox is marked, a valid email address must be 
entered in Purchasing & Payables > Vendors > Vendor Maintenance for the 
system to automatically send the email. Otherwise, a vendor copy is printed. 
The same applies if the Email Originator checkbox is marked. A valid email 
address must be entered in Payroll > Employees > Employee Maintenance. 
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RECEIVE AGAINST PURCHASE ORDERS 

9-Box > PO Receiving 

Overview 

The Purchase Order Receiving grid displays all purchase order receiving information 

for the DEPARTMENT. From the grid, users can receive items. 

Marking Receive POs Based On Department & Ship To Location P&P > 

Configuration > P&P Default Settings, allows users to receive items 

against POs having a Ship to Location matching the Ship To assigned to 

the user's Department. 

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Manage Documents 
Select this command to view, add, or delete 
document attachments for the highlighted record. 

Clear Quantity Column 

Select this command to clear the quantity 
columns for all items received on the current Add 
Received Items form to start the receiving process 
over. 

Activity (Required) 

The following activity walks through the process of how to receive against a PO. 

Receive Against PO 

SCENARIO: New computer equipment has arrived and needs to be received. 

 Click Add on the tool bar. The Add Received Items window displays. 

 In the PO Number field, enter “240043” to receive against or select the 

purchase order from the dropdown. Based on the entered PO number, the 

header (Vendor, Ship To, DEPARTMENT, and Requester) and Purchase 

Order Line Information grid are populated. 

 In the grid, double-click the item to receive. The Add Received Items 

window displays. 

 Receive the following items: 

DESCRIPTION 
PART 
NUMBER 

UNIT QTY 
CASE 
PACK 

ITEM 
COST 

Computer, 
Pentium 4, 1MB 

3094868 EA 1 1 $941.22 
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DESCRIPTION 
PART 
NUMBER 

UNIT QTY 
CASE 
PACK 

ITEM 
COST 

Monitor, 21” 
Dell Optiplex 

298873 EA 1 1 $470.02 

 In the Notes field, type any pertinent information. The notes display on the 

Received Items tab and Notes tab in IVEE > Purchasing & Payables > 

Payables > Invoice Processing. 

 Click the Save button at the end of the detail line to receive another item. 

Otherwise, mark the Close after update? checkbox. Then click OK. 

VENDOR MAINTENANCE 

9-Box > Vendors 

Overview 

Use the Vendor Maintenance menu item to look up Vendor information. Normally, 

this window is read-only. Contact the Purchasing Department regarding the process 

for adding a new vendor. 

PURCHASING AND PAYABLES REPORTS 

Vendors/Purchase Orders 

9-Box > Vendors/Purchase Orders Report 

Use this menu item to specify selection criteria for the following report options: 

REPORT  DESCRIPTION 

Vendor PO Totals 

Select this report to generate a report including 
PO paid amounts, encumbrances, FYTD balance, 
and vendor total amount for the fiscal year. The 
report also displays 1099 and Use Tax 
information. 

PO Pay History and Encumbrance 

Select this option to generate a report for the 
selected vendor. The report displays header 
information and item detail including PO total, the 
amount paid, and amount encumbered. 

Vendor Invoice History 

Select this report to generate a report for the 
selected vendor. The report displays invoice 
history including PO number, Voucher, and 
Invoice Amount. 
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REPORT  DESCRIPTION 

PO Aging 

Select this report to generate a report for open 
purchase orders. The system uses the As of Date 
to determine the age of the purchase order. The 
report includes vendor order name, PO amount, 
and totals and grand totals for each aging period 
(Under 30 days, 31-60 days, 61-91 days, and over 
90 days). 

Vendor PO History 

Select this report to generate a report for the 
current fiscal year for the selected vendor. The 
report displays PO number, PO Date, PO Status, 
Total Amount, Paid Amount, Encumbrance, 
Invoice Amount, and Invoice Date. The report also 
displays amount totals and grand totals 

 

Purchase Orders by Account 

9-Box > PO by Account Report 

Select this report option to generate an Account Purchase Order History or Account 

Purchase Order Pay History report for the specified account and date range. Mark 

the Open POs Only and Show Detail checkbox as applicable. 

SECTION SUMMARY 

In this section, we learned how to add, edit, and print requisition and purchase 

order information for the Department. Also, we received against purchase orders. 

In the next section, we learn how to add, edit and approve Warehouse requisitions. 
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SECTION ASSESSMENT 

 

1. How can the budget be checked for accounts on a requisition? 

a. Budget cannot be checked on requisitions 

b. Click in the account code field and press the CTRL + B  

c. From the Actions menu, select Check Budget  

2. List 3 notification options when using the Return Requisition action. 

3. It is necessary to approve the requisition _____ if a user is the originator of the 

requisition as well as an approver in the defined approval process. 

a. 3 times 

b. 2 times  

c. 1 time 

d. It is not necessary to approve the requisition 

4.  Documents can be attached to requisitions. 

a. True  

b. False 

5. When closing a requisition after completion, remember to mark the ______ 

checkbox to start the requisition approval process. 

a. Hold Account Distribution 

b. Close after update? 

c. Submit for Approval  

d. None of the above 

6.  Received items can be deleted in the grid. 

a. True  

b. False  
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iVisions – Warehouse 

Introduction 

In the Warehouse module, a Department may have its own warehouse or a central 

warehouse where all Departments can submit requisitions. Users have access to 

only requisitions for the warehouse they are granted access unless assigned as a 

Warehouse Central Site user. 

THE CONTROL PANEL 

9-Box > WH Control Panel      

Overview 

The Warehouse Control Panel allows users to review the status of requisitions, edit, 

delete, and create new warehouse requisitions. To view all (default) requisitions, 

click Apply. Users can limit the number of records to display in the Control Panel grid 

by selecting filter criteria as applicable and then clicking Apply. 

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Approval Log 
Select this command to view the approval 
sequence for the highlighted record in the grid. 

Manage Documents 
Select this command to view, add, and delete 
document attachments for the highlighted record 
in the grid. 

Shortcuts 
Select this command to access quick links to 
Vendor Maintenance, Projects, and Requesters. 

Copy Requisition 
Select this command to copy the selected 
requisition in the grid. The copy displays in the 
grid with “Copy of” in the name. 

Print Preview 
Select this command to view the File and 
Requesters copy of the selected requisition. 

Activity (Required) 

The following activity walks through the process of how to add a warehouse 

requisition. 

Section Topics 

• The Control Panel 

• Print Warehouse 
Requisitions 

• Print Shipping Receipts 

• Generate Warehouse 
Reports 
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Enter Warehouse Requisitions 

SCENARIO: Capital City Elementary School needs a few office and cafeteria supplies 

and has asked for help in processing the warehouse requisitions. 

WAREHOUSE REQUISITION 1  

Processing Instructions 

• Log in as bwire | v 

 

1. In the Control Panel window, click Add on the tool bar. The Add Warehouse Requisition window displays. 

2. On the Requisition Detail tab, complete the header information as follows: 

REQUISITION INFORMATION  

Req. Number: 1 Requisition Date:  

Department: Capital City Elementary School Date Required:  

Requester: Mandy Lifeboats Project: None 

Ship To:  Warehouse: Main 

In the grid, add the following line items:  

 
After entering a line item, click the Save icon. The system saves the item and calculates the extended price. Fields 
are cleared and ready for entry of another line item. 

Item # Description Qty Account Grant Project Unit Unit Price Ext Price 

100-002 Pens, Bic, Black Sanford, Liquid Accent Asst. 5 001.10.100.5419  50/Pk Current $   0.00 

100-004 Sanford, Liquid Accent, Assorted 5 001.10.100.5419  5/pk Current $   0.00 

        

        

        

        

        

        

        

    15     $   0.00 

 



 
 

 

 IVISIONS ESS AND WORKFLOW 70 
IVISIONS - WAREHOUSE 

  

 

WAREHOUSE REQUISITION 2 

Processing Instructions 

• None 

 

 In the Control Panel window, click Add on the tool bar. The Add Warehouse Requisition window displays. 

 On the Requisition Detail tab, complete the header information as follows: 

REQUISITION INFORMATION  

Req. Number: 2 Requisition Date:  

Department: Capital City Elementary School Date Required:  

Requester: Mandy Lifeboats Project: None 

Ship To:  Warehouse: Main 

In the grid, add the following line items:  

 
After entering a line item, click the Save icon. The system saves the item and calculates the extended price. Fields 
are cleared and ready for entry of another line item. 

Item # Description Qty Account Grant Project Unit Unit Price Ext Price 

100-004 Sanford, Liquid Accent, Assorted 1 001.10.100.5419  5/Pk Current $   0.00 

300-001 Wipes, Multi-Purpose 5 001.10.200.5419  Each Current $   0.00 

        

        

        

        

        

        

        

    15     $   0.00 
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WAREHOUSE REQUISITION 3 

Processing Instructions 

• Select Single Line Entry from the Actions menu to add line items. 

 

 In the Control Panel window, click Add on the tool bar. The Add Warehouse Requisition window displays. On the 

Requisition Detail tab, complete the header information as follows: 

REQUISITION INFORMATION  

Req. Number: 3 Requisition Date:  

Department: Capital City Elementary School Date Required:  

Requester: Mandy Lifeboats Project: None 

Ship To:  Warehouse: Food Service 

 Select Single Line Entry from the Actions menu. The Add Warehouse Requisition Lines window displays. Add the 

following line items:  

 
After entering a line item, click the Save icon. The system saves the item and calculates the extended price.  

Item # Description Unit Unit Price Qty Account Grant Project Ext Price 

400-001 Mixer, Hobart Each Current 1 001.10.100.5419  $   0.00 

400-003 Serving Cart, Stainless Steel Each Current 7 001.10.100.5419  $   0.00 

400-002 Spoons, Slotted  3/PK Current 6 001.10.200.5419  $   0.00 

400-004 Can Opener, Electric Each Current 1 001.10.300.5419  $   0.00 

400-005 Baking Pan, 13” x 7” Each Current 2 001.10.100.5419  $   0.00 

        

        

        

        

     0    33   $   0.00 
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WAREHOUSE REQUISITION APPROVAL 

9-Box > Warehouse Requisitions 

My Dashboard > Smart Card > Warehouse Requisitions  

Overview 

Requisitions with the Submit for Approval checkbox marked, begin routing through 

the approval process once the user clicks OK. Requisitions waiting for approval 

display in Warehouse Requisitions beneath the 9-Box or on the Warehouse 

Requisition Smart Card. 

Activity (Required) 

Approve Warehouse Requisitions 

 In the grid, mark the Process checkbox for each of the requisition(s) to 

approve. 

 From the Actions menu, select Approve Requisition. 

 Click OK to acknowledge message. The requisition no longer displays in the 

grid. 

PRINT WAREHOUSE REQUISITION  

9-Box > Print WH Requisitions 

Overview 

The Print Requisitions grid displays all requisition created by users in your 

DEPARTMENT. For users assigned to a Warehouse Central DEPARTMENT, the grid 

displays all requisitions routed completely through the approval process. 

Select filter criteria as applicable to limit the number of records to display in the grid 

and click Apply. 

From the Actions menu, the following command is available: 

COMMAND DESCRIPTION 

Print Requisition(s) 
Select this command to display the Print WH Req 
window. 
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 PRINT WAREHOUSE REQUISITIONS 

Highlight the record(s) to print. Select multiple records by holding down the 
CTRL key. 

The system generates a single .pdf document for all selected requisitions. 

Highlight the record(s) to print. Select multiple records by holding down the 
CTRL key. 

The system generates a single .pdf document for all selected requisitions. 

PRINT SHIPPING RECEIPTS  

9-Box > Print Shipping Receipts 

Overview 

When the warehouse ships an order to the DEPARTMENT, a shipping receipt is 

automatically created. Use Print Shipping Receipts to review receipts and to print 

receipts detailing contents of the warehouse shipment.  

To limit the number of records to display in the grid, select filter criteria as 

applicable and then click Apply. 

 SECTION TOPIC HEADING 

Highlight the record(s) in the grid to print. Select multiple records while holding 
down the CTRL key. 

Mark the Print only items currently being shipped checkbox to limit the number 
of receipts printed. 

A single .pdf document generates for all selected receipts. 

Highlight the record(s) in the grid to print. Select multiple records while holding 
down the CTRL key. 

GENERATE WAREHOUSE REPORTS 

Overview 

From the 9-Box, print the following warehouse reports: 
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COMMAND DESCRIPTION 

Catalog 

Select this report to generate a current 
warehouse catalog. In the Catalog window, 
specify whether the catalog is to include stock, 
non-stock, or all warehouse items. In Report 
Options, specify how to sort and group the 
catalog. 

WH Order By Account 

Select this report to generate a report of 
warehouse orders for a specific account, account 
mask, or account alias. Selection criteria also 
include options for order approval status. 

WH Orders By Requester 

Select this report to generate a report for all 
requesters of the selected Department or a 
specific requester. If a user is assigned to a 
Warehouse Central Site Departemtent, they have 
access to all requesters and all Departments. 

Stock History 
Select this report to generate a stock report 
specifying location(s) and stock item(s). 

WH Receiving Reports 
Select this report to generate a report for 
purchase order received items based on selected 
criteria. 

Wh-Info Link 
Select this report to view custom warehouse 
reports configured in IVEE. The report data can be 
exported to an Excel, Word, or CSV file. 

SECTION SUMMARY 

In this section, we created Warehouse Requisitions, printed requisitions, reviewed 

the Approval Q and generated Warehouse reports. 

In the next section, we work with the Employee Time Card Entry and Employee 

Leave Plans. 
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SECTION ASSESSMENT 

 

1. The Warehouse Control Panel allows users to review the status of requisitions 

and ______________ warehouse requisitions.  

a. Add 

b. Edit 

c. Delete 

d. All the Above  

2. When the Warehouse ships an order to the department, a ____________ is 

automatically created. 

a. PO 

b. Shipping Receipt  

c. Requisition Memo 

d. Report 
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iVisions – Payroll 

Introduction 

The Payroll module allows users to review Employee Positions and Pay records, 

enter time card information, and review leave plan information for actual and 

substitute employees. Access to Employees is based on assigned Department unless 

tied to the main Payroll Department which has access to all employees. 

Access to Employee Positions and Pay requires the assignment of a 

Payroll User Role. Users not assigned to a Payroll User Role receive an 

error message when accessing Employees Position and Pay. 

EMPLOYEE POSITIONS AND PAY 

9-Box > Positions and Pay 

Overview 

Employee Positions and Pay allows a user assigned to a Payroll User Role to view 

position and supplemental pay records for employees assigned to their 

DEPARTMENT. A user cannot add, edit, or delete records within this grid.  

EMPLOYEE TIME CARD ENTRY 

9-Box > Time Card Entry 

Overview 

Employee Time Card Entry is an optional payroll feature. If the district has pushed 

payroll hours entry out to the Departments, time card information can be entered. 

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Submit Pay Period for Approval 
Select this command to submit the hours entry 
batch to the next approver.  

Approval Notes 
Select this command to enter a Time Approval 
Batch Note. 

Save 
Select this command to save changes made to the 
selected record. 

Section Topics 

• Employee Positions 
and Pay 

• Employee Time Card 
Entry 

• Review Employee 
Leave Plans 
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COMMAND DESCRIPTION 

Lock 
Select this command to prevent any other 
changes from being made to the record(s). 

 

Activity (Required) 

The following activities walk through the process of entering hours for an actual 

employee. 

Enter Time Card Hours 

 In the Employee Time Card Entry window, from the DEPARTMENT 

dropdown, select Capital City Elementary School.   

 Mark the Show Sub Records checkbox to include Substitutes in the grid. 

 Click Apply to populate the grid. 

 Double-click a record to edit and update the records for the following 

employees: 

After updating the record, be sure to click the Save icon to save 

changes. 

 

NAME POSITION RATE 
REG 
HRS 

OTHER 
HRS 

OT 
HRS 

Ball, Crystal Student Security Aide $13.75 70.00 10.00 0.00 

Wire, Barb Administrative Asst. $12.75 80.00 0.00 4.00 

Fley, Sue Substitute – Certified $70.00 6 0.0 0.0 

 

 Highlight all records in the grid. From the Actions menu, select Lock. The 

Posted column in the grid updates to display the date the Lock command is 

selected (nothing posted to general ledger). The Status column displays the 

pay period posting status (posted or unposted). 

 From the Actions menu, select Submit Pay Period for Approval. 

 Click File > Close to exit Employee Time Card Entry. 

 Navigate to Payroll > Attendance > Approved Time Worked Balances to 

review Sue’s balance. 
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 TIME CARD ENTRY 

Once records are locked, payroll knows hours entry for the pay period is 
complete. At this point, records cannot be unlocked. 
 
If an approval process has been set up for Time Card Entry batches the 
approver sees the batches in Payroll > Attendance.  

LEAVE PLANS 

9-Box > Leave Plans 

Overview 

Employee Leave Plans allows a user designated as a supervisor to review detailed 

leave plan information for their employees. (The Show leaves with transaction detail 

checkbox must be marked.) 

To limit the number of records to display in the grid, select filter criteria as 

applicable and then click Apply. The grid is read-only. 

 

SECTION SUMMARY 

In this section, we reviewed Employee Positions and Pay records, entered time card 

information and reviewed leave plan information for actual and substitute 

employees. 

In the next section, we work with the different functions in the Human Resources 

module. 
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SECTION ASSESSMENT 

 

1. When in the Employee Positions and Pay grid, you can add, edit, and delete a 

record. 

a. True 

b. False  

2.  What function is performed to allow payroll to know the DEPARTMENT has 

completed the hours entry for a Pay Period. 

a. Submit for Approval 

b. Lock records Email Alert 

3.   A Department can edit records once they are locked. 

a. True 

b. False  
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iVisions – Human 

Resources 

Introduction 

The Human Resources module provides access to view Employee Positions and Pay 

information, enter Employee Personnel Actions Requests (ePARs), and work with 

Employee Leave Plans and Requests. The district can define different PAR types 

(defined in Infinite Visions) to best suit the needs of the district. Within iVisions 

Online Workflow, the following standard types of ePARs are entered: 

• New Hire Assignment 

• Current Employee Assignment 

• Pay Change 

• Staff Termination 

• Position Request 

• Leave of Absence Request 

Access to the PAR Types to view and process is dependent on defined user security.  

In addition to ePARs, users identified as supervisors can access the Evaluations 

menu item. 

EMPLOYEE PERSONNEL ACTION REQUESTS 

9-Box > PARs 

Overview 

To limit the number of records to display in the grid, select filter criteria as 

applicable and then click Apply. 

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Print 
Select this command to print the PAR for the 
selected record. 

Manage Documents 
Select this command to view, delete, or add 
attachments to the selected record. 

Section Topics 

• Employee Personnel 
Action Requests 

• Approve ePARs 

• Employee Evaluations 
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COMMAND DESCRIPTION 

Send PIN Email 
Select this command to forward a PIN email to 
recipients as configured in Infinite Visions > 
Security. 

Copy Selected PAR Select this command to copy the selected record. 

Activity (Required) 

The following activity walks through the process of how to enter a New Hire 

Assignment PAR. 

Enter a New Hire Assignment PAR 

SCENARIO: Hal Apeno needs to hire a new teacher to fill a new position at Capital 

City Elementary School. Enter the PAR to get the process started to fill the teacher 

position. 

 Click Add on the tool bar. The Add ePAR window displays. 

 From the Choose a PAR Type dropdown, select Add New Hire Assignment. 

 Click Next. 

 Below Job Selection, click Add on the tool bar. The Select Job window 

displays. 

 In the Control Code field, type “I-200-10127” and select the applicable 

filter logic from the dropdown.  

 Highlight the position in the grid and click OK. 

 On the PAR Information tab, enter the following information: 

FIELD NAME FIELD VALUE 

Effective Date Current date 

First Rodney 

Middle M 

Last  Dangerfield 

Address 
2877 S. No Respect Blvd. 
Capital City, IV 19335 

SSN 687-23-9678 

 Choose the Review tab. 
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 Mark the Submit for Approval checkbox. 

 Mark the Close after update? Checkbox, and then click Save. 

EMPLOYEE PERSONNEL ACTION REQUESTS 

My Dashboard > Smart Card > ePARs 

Overview 

To limit the number of records to display in the grid, select filter criteria as 

applicable and then click Apply. 

From the Smart Card menu, the following options are available: 

OPTION DESCRIPTION 

Return to Originator 
Select this command to return the PAR to the 
person who created it. 

Return to Prior Approver 
Select this command to return the PAR to the 
person who approved it before you. 

Approve PAR 
Select this command to add your approval to the 
PAR request. 

Cancel PAR 
Select this command to remove the PAR from the 
approval process. 

Print PAR Select this command to print the selected PAR. 

Alternate Approvers 
Select this command to add an alternate 
approver. 

From the ePARs grid, the following Action command is available: 

COMMAND DESCRIPTION 

Manage Documents 
Select this command to attach a document to the 
PAR. 

Activity (Required) 

The following activity walks through the process of how to approve an ePAR. 

Approve an ePAR 

 Click the ePARs Smart Card to expand the ePARs ready for approval. 

 Click the green check mark to approve the ePAR. The ePAR is removed 

from the Smart Card list.  

Smart Cards are visible only if approval records exist.  Once the 

last Smart Card record is approved, the Smart Card disappears 

from My Dashboard. 
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Once the person who is defined as the last approver has 

approved the PAR, it is routed to Human Resources. HR reviews 

the PARs in 9-Box > HR – PAR Completion or My Dashboard > 

Smart Card > HR – PAR Completion and as applicable chooses 

Complete from the Smart Card or Mark Completed from the  HR 

– PAR Completion Actions menu. The PAR is then routed to 

Payroll, the last step in the PAR approval process. Go to 9-Box > 

HR – PAR Completion or My Dashboard > Smart Card > PR – PAR 

Completion, and, as applicable, choose Complete from the 

Smart Card or Mark Completed from the PR – PAR Completion 

Actions menu. Then review the PARs and take any necessary 

action before marking the PAR complete. 

EMPLOYEE EVALUATIONS 

9-Box > Evaluations 

Overview 

Users who are identified as supervisors can add, edit, or view evaluations for the 

employees they supervise. Supervisors assigned to a Payroll Central Site attribute 

have access to all employee evaluations. To limit the number of records to display in 

the grid, select filter criteria as applicable and then click Apply. 

By default, the system displays employee evaluations from all History 

Connection Groups with Employee Evaluations marked in Security > 

Workflow Configuration History Connection Groups unless in the filter 

criteria the Current Year Only checkbox is marked. 

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Manage Documents 
Select this command to view, delete, or add 
attachments to the selected employee evaluation 
record. 

Print Evaluations 

Select this command to generate a PDF copy of 
selected evaluations. This command is also 
available from the Actions menu in the Edit 
Evaluation window. 
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Activity (Required) 

The following activity walks through creating an employee evaluation. 

Review Evaluation 

 Click Add. 

 From the Name dropdown, select Mandy Lifeboats. 

 Complete the fields on each tab as designated by your instructor. 

 Review the evaluation. 

SECTION SUMMARY 

In this section, we learned how to enter and approve Employee Personnel Action 

Requests (ePARs). We also learned how to enter Evaluations. 

In the next section, we work with Fixed Assets. 
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SECTION ASSESSMENT 

 

1. ePARs route through an approval process. 

a. True  

b. False  

2.   List 3 PAR types. 

a. ___________________ 

b. ___________________ 

c. ___________________ 

3.   What type of user can create an Evaluation? 

a. Manager 

b. Supervisor * 

c. Attendance Clerk 
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iVisions – Fixed Assets 

Introduction 

The Fixed Assets module provides access to several reporting options. The Workflow 

menu displays only assets for your assigned Department unless assigned to a Fixed 

Assets Central Site Department. 

FIXED ASSET REPORTS 

9-Box  

Overview 

The following reports are available within the 9-Box menu. 

REPORT DESCRIPTION 

Asset Reports 

Select this report to generate an asset report 
based on the Selection Criteria and selected 
Report Options including: Report Type (Listing of 
Fixed Assets, Listing of Non-Fixed Assets, Listing of 
Fixed and Non-Fixed Assets, Disposed Assets, 
Asset with Spit Codes or Assets Missing Account 
Codes) and Page Break by Location or by 
Category/SubCategory. To schedule a report, 
mark the Schedule Report checkbox. The Schedule 
Report window displays. In this window, select 
the report parameters and email recipients, as 
applicable.  

Inventory Form 
Select this report to print inventory sheets to use 
for manual inventory based on the selection 
criteria, asset type, and report type selected. 

Disposal Form 
Select this report to generate a PDF copy of the 
Disposal Form. 

FA – Info Link 
Select this menu to access predefined asset 
reports. 

SECTION SUMMARY 

In this section, we reviewed the different reports found in the General Fixed Assets 

module. 

In the next section, we discuss payment processing in Receivables. 

Section Topics 

• Fixed Asset Reports 
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iVisions – Receivables 

Introduction 

The Receivables module provides access to Payment Processing. 

PAYMENT PROCESSING 

9-Box > AR Payments 

Overview 

The Payment Processing grid displays the status of payments against invoices. To 

limit the number of records to display in the grid, select filter criteria as applicable 

and click Apply.  

From the Actions menu, the following commands are available: 

COMMAND DESCRIPTION 

Print Receipt 
Select this command to generate a PDF receipt for 
the highlighted payment record. 

Suspend Payment 

Select this command to suspend the highlighted 
payment in the grid not ready for selection on a 
deposit batch. When entering a payment, mark 
the Save As Suspended checkbox. 

Activity (Required) 

The following activity walks through the processing a payment. 

Process a Payment 

SCENARIO: Absolute Dance Studio rents Capital City Elementary School’s auditorium 

monthly. They pay the school $70.00 a month. Process this month’s payment. 

 Click Add on the tool bar. The Add New Payment window displays. 

 Use the following information to process the payment: 

FIELD NAME VALUE 

Invoice 18 

Section Topics 

• Payment Processing 
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FIELD NAME VALUE 

Method Check 

Check # 2015 

Group ID HA 

Payment $70.00 

 Review the line detail. 

 Click Save. 

 Mark the Close after update? checkbox and click OK. 

 SUSPENDING PAYMENTS 

Payments attached to an invoice with a status of closed cannot be suspended. 

Only payment records with a status of ready to deposit can be suspended. 

SECTION SUMMARY 

In this section, we learned how to process and suspend payments in the Receivables 

module. 
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SECTION ASSESSMENT 

 

1. A closed invoice payment cannot be suspended. 

a. True  

b. False  

2. Payment records with what type of invoice status can be suspended. 

a. Ready to Pay  

b. Open 

c. Closed 

 


